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In all our spatial products there is the Draw Tab where you can do a number of 

different drawing operations: 
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We will take up each section of this tab. 

 

Drawing Basics 
 

Before we cover all the tools available in this tab, we will go over some basics 

of how drawing works. 

 

Active Layers 
 

When you draw an object with any one of the drawing tools it gets drawn to any 

layer that you have set as Active. A layer is made active by right clicking and 

then selecting Active, this will then be greyed indicating it is active and the 

layer name will appear with bolded letters as well further indicating the layer is 

now active: 
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Any item I draw will now be drawn to this layer. The items will automatically 

pick up the styling you have set for the layer: 
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If you have not set any layer as active, when you draw an item, you will be 

prompted to create a new layer for it, click Yes and then a new layer is added for 

you: 
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When a new layer is created for you like this, it is automatically made active as 

you will see by its bolded letters, you can continue drawing objects and they will 

continue being drawn to this new layer: 

 

 

 

To make it not active you can of course right click on the layer and click this 

off: 

 



Draw Tab User Guide 

8 

 

 

 

 

 

You can change the name of this new layer by double clicking on it and typing it 

in. You can then go into its Layer Properties by right clicking and selecting 

Properties and then change the styling of the layer: 
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For full information on how the Layer Properties window works refer to the 

Layer Properties Guide. 

 

Capturing Attribute Information 
 

To enter attribute information about the objects in your layers right click on the 

layer then select View Data, this will bring up the Layer Data Grid which con-

tains all attribute information associated with a layer, here you can enter in a de-

scription for each object, in the Description column: 

 

https://primethought.biz/help/spatialvu/layer_properties/
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To find out which object each row in this grid relates to you can select the row 

by clicking next to it on the left in the white area, then click Highlight Selected 

and the object will be highlighted in the scene: 
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Once I’m done capturing information for this layer, I can exit the Layer Data 

Grid and the data is saved, then I can put a text label on so I can see the name of 

each object by right clicking on the layer, hovering on Text Labels and then se-

lecting the column I want to put a text label for:  



Draw Tab User Guide 

13 

 

 

 

 

 

 



Draw Tab User Guide 

14 

 

 

 

How text labels appear can be styled in the Layer Properties window under the 

Text tab: 
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For full information on how the Layer Properties window works refer to the 

Layer Properties Guide. 

 

Further columns can be added in the Layer Data Grid and existing columns can 

be edited and deleted, for full information on how the Layer Data Grid works re-

fer to the Layer Data Grid Guide. 

 

Adding a New Layer 
 

To add a new layer yourself that you can then draw to, select the Add Layer 

button in the quick access toolbar: 

 

 

 

https://primethought.biz/help/spatialvu/layer_properties/
https://primethought.biz/help/spatialvu/layer_data_grid/
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This will then bring up the Layer Properties window where you will set the 

properties of the new layer you are adding, under the General tab you can type 

in the name of the layer, then under the Data tab you must initialize some basic 

columns for the new layer so that geometries can be drawn to it, Simple will just 

create a Geometry column, but recommended is to choose With ID and De-

scription, which will create a geometry column and an ID and Description col-

umn, then click Create, you can then change the names of these columns if you 

like and even add further columns in the grid below but for now we will just 

leave it like that: 
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Then in the Styling tab you can set up the styling for the new layer: 
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You can then click OK and the new layer is added, this layer is of course empty 

but you can now start drawing to it by right clicking and making it Active and 

then start drawing: 
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Precision Draw 
 

Precision Draw is a tool available in all our spatial products that allows you to 

lock your scene in various ways to allow for precision drawing. It is found at the 

bottom of the spatial pane. For full info on this tool refer to the Precision Draw 

Guide: 

 

 

 

Draw Options 
 

https://primethought.biz/help/spatialvu/precision_draw_tool/
https://primethought.biz/help/spatialvu/precision_draw_tool/
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MultiDraw 
 

MultiDraw will keep whatever drawing tool you choose active and allow you to 

keep drawing objects in the scene without the need to go back and reselect the 

drawing tool. Click on MultiDraw to make it active (this is indicated by it being 

greyed) then choose your drawing tool and you can then begin drawing in your 

scene: 
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The drawing tool you have chosen will remain active until you choose another 

tool or cancel MultiDraw by clicking it off. 

 

Selected Layer Grid 
 

You can bring up the Layer Data Grid of the layer that is highlighted in the layer 

control by clicking Selected Layer Grid. Here you can view the attribute data 

of the layer and edit it if you want as well: 
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2D 
 

 

 

In the 2D tab are various drawing tools you can use to draw 2D objects.  

 

2D Point, 2D Linestring, 2D Polygon 
 

To use one of these tools, click on it and it will then be greyed indicating it is 

now active, you can then click in your scene to start drawing. To draw points, 

you just click. To draw a linestring or polygon, click to draw each vertex of the 

object until you are done at which point you will double click to end the draw-

ing. 
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To close a linestring, press the C key on your keyboard instead of double click-

ing to end the drawing. 
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After drawing the first object you will need to click on the tool to make it active 

again for each new object you draw, if you want it to stay active you will click 

MultiDraw before selecting the tool, refer to Draw Options section for data on 

this. 

 

2D Text 
 

Clicking on the 2D Text tool will bring up a dialogue where you will specify the 

text you want to draw and the font, size and angle of this text. 

In the box below type in the text, you will see this text then appears on your cur-

sor as you hover in your scene. (The size units of the text were originally in de-

grees, in later versions in meters): 
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Placement refers to the placement of the text in relation to the cursor, so you 

can put it to the bottom right of the cursor, the centre etc. 
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Once you have entered the text and chosen its settings, you can then just click at 

the point in the scene where you want to place it and it will be drawn: 
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You can keep clicking and placing the same text or type in new text in the dia-

logue and change its properties if you want and then place that, when you are 

done exit the dialogue and the tool will no longer be active. 

 

Arc/Circle 
 

Clicking on the Arc/Circle tool will bring up a dialogue where you can specify 

the parameters of a circle or arc you can draw: 
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First you will choose whether you want to draw a circle or arc; circle is the de-

fault, and you will have to specify specifically by ticking on Arc to draw an arc. 

Then choose whether you want a filled circle/arc (Fill) and whether you want it 

to be 3D or not (3D). In this example I will just be drawing a 2D filled circle: 

 

 

 

Next choose the Draw Type which is how you will draw the circle/arc, I will 

just leave the default which is from the centre outwards as a radius (Center, Ra-

dius). Finally, you can choose to have a prespecified radius by entering it in by 

Radius(m), this is in meters, I have chosen to have a 10 kilometre radius, then 

you will tick on the checkbox next to it.  

 

Then tick on the Draw checkbox and as you hover in your scene you will see 

the prespecified circle/arc on your cursor, you can then double click at the de-

sired point to place it: 
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Alternatively, you can draw the radius dynamically in the scene, just leave the 

Radius(m) checkbox ticked off and then tick Draw. Then click and drag in your 

scene to start drawing the circle/arc, as you draw the radius will show dynami-

cally by Radius(m), double click to finish: 

 

 

 



Draw Tab User Guide 

35 

 

 

 



Draw Tab User Guide 

36 

 

 

 

Tessellation 
 

The Tessellation tool allows you to build a tessellation - a repeating pattern of 

polygons that covers an area with no gaps or overlaps. 
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First you will choose what Shape you want to use in the tessellation- Rectangle 

or Hexagon. Then for the Boundary Mode you can choose either Select, which 

will make the boundary from selected elements in an existing layer that you 

have selected with one of the selection tools, or you can choose Draw and this 

will allow you to draw your own boundaries. In this example we will choose 

Rectangle and the Draw option: 

 

 

 

 

 

Now we click the Draw Boundary button and go to our scene to draw the 

boundary, left click to start drawing, each click is a vertex of the boundary, dou-

ble click to finish. Show Boundaries is ticked on by default, if you tick it off 

you will not see the boundaries on the scene when you draw them: 
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You can right click to undo a vertex of the boundary as you are drawing. 
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Your boundary is now drawn, if you want to redraw it you can click Clear 

Boundaries and then draw it again: 
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The Origin, X Axis, Y Axis and Z Axis of the tessellation can be custom set, to 

get back the regular scene axes, click Get scene axes: 

 

 

 

The next step is to specify the Width and Height in meters of the cells of the 

tessellation, in this example I will make them 10 kilometres (10 000 meters), fi-

nally click Draw Tessellation and your tessellation will be drawn in a new 

layer: 
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Each block of the tessellation is automatically assigned an ID which then dis-

plays on the blocks as a text label.  

 

I will just make this tessellation layer more transparent so I can see underneath it 

better by going into its Layer Properties, and under the General tab, adjusting 

the transparency slider: 
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Here is one more example using some different parameters. Here I have chosen 

the Select Boundary Mode. I have also chosen to have Hexagons instead of 

Rectangles for the cells of the Tessellation. The cell Width and Height I have 

chosen as 1000 metres (1KM): 
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I have also selected the object in my scene that I will use as the boundaries for 

my Tessellation: 
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I then click Draw Tessellation and my tessellation is drawn: 

 

 

 

Once you have created your tessellation you can do aggregations into the tessel-

lated area, select points that lie within it, theme on the different blocks etc. For 

data on operations like these refer to these guides: 

• Aggregate Tool 

• Select by Location 

• SpatialXL Guide, Theming section. 

 

3D 
 

https://primethought.biz/help/spatial-tools/aggregate-tool/Aggregate-Tool-User-Guide.pdf
https://primethought.biz/help/spatial-tools/select-by-location-tool/index.html
https://primethought.biz/help/spatialxl/spatialxlhelp/index.html
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In the 3D section of the Draw tab are various 3D drawing tools.  

 

3D Point, 3D Linestring, 3D Polygon 
 

The 3D Point, 3D Linestring and 3D Polygon tools work by clicking on them, 

they will then be greyed to indicate they are active, then you will click in your 

scene to begin drawing, for 3D Point simply click once to draw the point, for 

the 3D Linestring and 3D Polygon tools, click to draw each vertex of the object 

and then double click to finish: 
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You can rotate the objects by selecting one of the snapping tools and then snap-

ping to the object. Your cursor will change to a star when it has found an object 

or vertex to snap to, then click on it, hold down ctrl and then drag to rotate: 
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To close a linestring, press the C key on your keyboard instead of double click-

ing to end the drawing. 
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After drawing the first object you will need to click on the tool to make it active 

again for each new object you draw, if you want it to stay active you will click 

MultiDraw before selecting the tool, refer to Draw Options section for data on 

this. 

 

3D Text 
 

Clicking on the 3D Text tool will bring up a dialogue where you will specify the 

text you want to draw and the font, size (units in meters) and angle of this text. 

In the box below type in the text, you will see this text then appears on your cur-

sor as you hover in your scene: 
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Placement refers to the placement of the text in relation to the cursor, so you 

can put it to the bottom right of the cursor, the centre etc. 
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Once you have entered the text and chosen its settings, you can then just click at 

the point in the scene where you want to place it and it will be drawn: 
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You can keep clicking and placing the same text or type in new text in the dia-

logue and change its properties if you want and then place that, when you are 

done, exit the dialogue and the tool will no longer be active. 

 

Rectangle 
 

The Rectangle tool allows you to draw a rectangle, clicking on it brings up the 

following dialogue: 
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You will specify left and right offsets from the centre line of the rectangle, this 

sets the width, then you can prespecify a length for the rectangle as well and 

then tick on Lock next to it to lock this length, if you do not have Lock ticked 

on you can choose the length as you draw it, in this example I have made offsets 

of 100 meters on either side giving a total width of 200 meters for the rectangle, 

then the Length I have chosen not to specify: 

 

 

 

Next, choose what kind of drawing to make of the rectangle, you can choose 

Polygon (filled, solid rectangle), Closed (a closed linestring showing just the 

border of the rectangle, 2 Lines (2 lines showing the border of either side of the 

rectangle), 3 Lines (2 Lines showing outside borders of either side of rectangle 

and 1 centreline) and lastly you can choose whether you want this to be a 3D 

rectangle or not, in this example I will do a 2D Polygon: 
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Lastly, tick on Draw to start drawing, click in the scene at the desired point and 

then move your mouse to place the rectangle exactly as you want, click one 

more time to finish (as you are drawing, you can right click to unplace the rec-

tangle and replace again at another point): 
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Drawing Styles 
 

 

 

The Drawing Styles section of the Draw tab is where you can specify styling for 

specific elements in a layer. The styling for a layer is set in the Layer Properties 

of that layer, but you can choose to style specific elements in that layer differ-

ently. 

First you would tick off Style From Layer, this will ungrey these settings and 

allow you to edit them. Then you would select the element/ elements you want 

to style with one of the selection tools: 
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Then choose the properties you would like to set for that selected element, when 

done click Apply to selected and the styling will be applied to that element: 
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As long as Style From Layer remains ticked off every new element you draw 

will have the styling specified here. Once you are done setting styling for spe-

cific elements you should tick this back on, and these settings will be greyed out 

again: 

 

 

 

Dimensioning 
 

 



Draw Tab User Guide 

66 

 

 

In the Dimensioning section of the Draw tab you can draw elements specifying 

dimensions of various sorts. 

 

Length Dimension 
 

The Length Dimension tool can be used to draw a length indicator in metres 

next to objects in your scene, simply click on the tool to make it active, it will 

then be greyed, then click in your scene and move to the end point, then click 

again to finish (while drawing you can right click to undo and then replace it): 
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Your length dimension has been drawn and added in a new layer called Dimen-

sions. This layer can of course be styled like any other in its Layer Properties. 

 

Excavation Instructions 
 

The Excavation Instructions tool is covered in the Excavation Instructions 

guide: 

 

  

https://primethought.biz/help/spatial-tools/excavation-instructions/index.html
https://primethought.biz/help/spatial-tools/excavation-instructions/index.html
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Support 

 

   

  

T:  +27871354351 
 
support@primethought.biz  - primethought.biz  
Kyalami Estate, Midrand, Johannesburg,  
1684, South Africa 
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